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Speed up your video-editing
and effects work with the 2014
release of Premiere Pro CC
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With Adobe’s full suite of desktop apps, Behance
integration and file storage and syncing, a CC
membership is essential for any creative pro.
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Photoshop is the world’s leading image-editing
application‚ and for good reason. The 2014
release brings a plethora of new tools!

ILLUSTRATOR CC 2014
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With Live Shapes, the new Pen tool preview and a
number of other improvements, the 2014 release
of Illustrator CC is guaranteed to speed up your
design workflow…

DREAMWEAVER CC 2014
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In Dreamweaver CC 2014, Adobe has addressed
workflow issues, fixed annoyances and added
tools to speed up the web development process.

PREMIERE PRO CC 2014
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welcome

Improved masking and tracking, new After Effects
integration and a faster editing workflow makes
Premiere Pro CC the tool of choice for editors.

Adobe Creative Cloud offers designers, web and
mobile developers, motion artists and video editors
a complete toolset for creating and collaborating
wherever they are located. And if you haven’t yet
signed up, you’re well and truly missing out on
world-class tools and services that will boost your
creativity and speed up your workflow.
In the 2014 release of Creative Cloud, which is
available right now, Adobe has added a raft of new
features to its popular desktop apps, released
numerous mobile apps and even released some
cutting-edge hardware (although the latter is sold
separately). Over the pages of this guide you’ll
discover why a Creative Cloud membership is
essential to creating better work, no matter what
you do or where you do it…

Adobe has launched five new iOS apps – all of
which work perfectly with your CC membership,
enabling you to create on the move.

FIVE NEW MOBILE APPS

INK AND SLIDE

14

16

The stunning new precision stylus and digital ruler
from Adobe let you design anywhere – and take all
your Creative Cloud assets with you…

CREATIVE CLOUD MYTHS
Adobe evangelist Terry White debunks some
common Creative Cloud myths…
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what’s included in Creative Cloud 2014

Create a personalised ProSite

THE ULTIMATE CREATIVE TOOLSET

Creative Cloud 2014
Not sure whether to join Creative Cloud? Check out the
options and what you get for your money…

A

s a creative professional, a smooth,
efficient workflow is key. It enables
you to focus on what’s important –
your creativity.
And with a Creative Cloud membership,
you can take your workflow to the next level. You
can start on the move with Adobe’s excellent iOS
apps, before moving onto the desktop, then sharing
and collaborating with others around the globe via
Behance. You can seamlessly move between any
desktop apps, taking your illustrations into After
Effects, say, for an ultra-efficient motion graphics
workflow. Whatever you do, a Creative Cloud
membership will enable you to do it more efficiently.
There are many Creative Cloud options
depending on your requirements. For instance, if
you’re a photographer you can get the Photography
membership – which includes the latest versions of
Photoshop and Lightroom – for just £8.78 per
month. If you’re just looking for a single app, you can
choose from any of Adobe’s desktop apps for £17.58
per month. For creative professionals though,
undoubtedly the best value membership is the
Complete package.
	Costing £46.88 per month if you commit
annually, or £70.32 per month if you want to cancel
at any time, the Complete membership gives you
everything you need to design and output projects
at breakneck speed. There’s also student and
teacher pricing available at £15.88 and a special
offer for current Creative Suite users costing £27.34
per month (see www.adobe.com/go/creativebloq for
full terms and conditions). In the Complete package
you get all of Adobe’s desktop apps:

Behance enables designers across the
globe to collaborate and showcase their
work. What’s more, it’s completely
integrated with Adobe Creative Cloud,
making it easy to get your work online.

■ Photoshop – image-editing and composition
■ Lightroom – digital photo processing and editing
■ Illustrator – vector graphics and illustration
■ InDesign – page design and layout for print and
digital publishing
■ Premiere Pro – video production and editing
■ After Effects – cinematic visual effects and
motion graphics
■ Dreamweaver – web and mobile design
■ Muse – website design without code
■ Flash Professional – interactive experiences,
game design, and mobile device packaging
■ Acrobat XI Pro – create, edit and sign PDF
documents and forms
■ Audition – audio recording, mixing and restoration
■ Bridge – creative asset management
■ Edge Animate – create interactive web content
■ Edge Code – code HTML, CSS and JavaScript
■ Fireworks – image-editing for websites and apps
■ Flash Builder – IDE for coding Flash apps and
mobile device packaging
■ InCopy – collaborate with copywriters and editors
■ Prelude – Metadata logging and rough cuts
■ Media Encoder – output video files for virtually
any screen
■ Scout – profile Flash games on web and devices
■ SpeedGrade – film finishing and colour grading
■ Story Plus – collaborative screenwriting, reporting
and scheduling
■ PhoneGap Build – package mobile apps in
the cloud
■ Prelude Live Logger – work faster with smarter
video logging
■ Gaming SDK – create ActionScript games
■ Extension Manager – install and manage
your extensions
■ ExtendScript Toolkit – add scripts to your
creative apps
The desktop apps alone represent incredible value
for your money, but that’s not all you get! Where
Creative Cloud really comes into its own is in its
file storage, sharing, syncing and collaboration
capabilities. With the complete plan you get 20GB
of cloud storage. Plus, using Adobe’s free mobile
apps you can sync your work, themes, brushes and
so on – so wherever you are you always have access
to your work and can keep creating.
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what’s included in Creative Cloud 2014

Set up your own professional portfolio in just six easy steps…

CLICK HERE TO FIND
OUT MORE ABOUT
A CREATIVE CLOUD
MEMBERSHIP

Behance, ProSite and much more

As well as the ability to store and sync files with
different machines and apps, your Creative Cloud
membership enables you to upload your work to
Behance – the incredibly popular portfolio platform.
Behance is a portfolio site that every
designer knows about. It has, in relatively recent
times, become a thriving community where creatives
can upload their work and get feedback from their
peers. It’s also the go-to place for many art directors,
meaning if you have your work showcased on
Behance, then the next big commission could
possibly be just around the corner.
With over 50 million visitors each month,
it’s fair to say that Behance is one of the most
popular platforms the industry has ever seen. It
enables up-and-coming designers to showcase their
talents across the globe – gaining the exposure they
deserve. Adobe wants to make it easier for
avid users of Creative Cloud to upload their latest
projects by integrating some of Behance’s best
community features directly into Creative Cloud. If
you have a CC membership, Behance is a fantastic
way to take your work from desktop to online in no
time at all – and start getting feedback on work in
progress, collaborate with other designers or simply
showcase your latest creations.
You can post work directly to Behance with
Photoshop and Illustrator or using the Creative
Cloud desktop or mobile apps.
To share your work directly from
Illustrator CC or Photoshop CC, you’ll need to
select File>Share to Behance or you can click on the
Share icon in the lower-left corner. Be aware that
you’ll have to crop an image from your project to be
displayed on the Behance portfolio site (the first
time you share from Photoshop CC or Illustrator
CC) so choose wisely, as that’ll be the first aspect of
your work that visitors will come across.
Behance has become bigger and better
than ever. As a Creative Cloud user, you should be
taking full advantage of this to get your work seen
by more of the right eyes.
You’ll need to have a paid Creative Cloud
membership to take full advantage of the free
Behance ProSite. This is the personal portfolio site
service that seamlessly syncs with Behance. You’ll
also have to link your Creative Cloud membership

with your Behance account to share your work – if
you’re yet to create an account, the Creative Cloud
app will prompt you to do so. In a nutshell, ProSite
enables you to create a fully customised personal
website extremely quickly, publishing to your own
URL and without any reference to Behance
or ProSite directly. See right for a quick tutorial on
using the service – you can get up-and-running with
the service and have a bespoke portfolio online in
no time at all.
	Other web services include access to the
entire library of Typekit fonts (and there’s many,
many typefaces here) meaning you can add
beautiful web fonts to your websites (and use them
in print and other projects) with very little hassle.

1 Select a layout

2 Choose your projects

3 Drag and drop

4 Customise

5 Publish your ProSite

6 Share work to Behance

First, make sure you have a Behance profile set
up, then visit the ProSite builder at www.
prosite.com. Log in to your account, and follow
the instructions to start building your ProSite.
Remember, ProSite is included within your
Creative Cloud membership, so there’s no
additional cost.

Underpinning the entire ProSite system is the
idea of projects. These are like folders within
your portfolio, which let you organise the work
you want to show into distinct areas. How you
arrange your projects is entirely up to you, but
you’ll need at least one to be able to start
building your ProSite.

Creative Cloud Market

In addition to this, you get access to the brand new
Creative Cloud Market. This brings you a collection
of high-quality, curated assets for creatives by
creatives. The royalty-free assets include vector
graphics, icons, patterns, UI Kits, for-placement
images, branding layouts, wireframes, charts, vector
shapes, repeatable patterns, backgrounds and
brushes and more. All free to members of Creative
Cloud (except for those on the cut-price
Photography Plan), they’ve been commissioned by
what some of the most talented and experienced
Creatives on Behance. Right now you can only
access the assets via the desktop app, but iOS
and browser-based versions are in the works. You’ll
be able to download up to 500 unique assets each
month with your CC membership.

Once you’ve got your projects uploaded to your
Behance profile, you can drag and drop them
from the Projects panel into the Gallery tab.
This makes the projects available as part of
your ProSite. The system will also pick up any
changes you make to your projects, for
super-easy updating later.

The Design tab provides access to the
customisation tools that you can use to make
your ProSite uniquely yours. There are lots of
different elements you can adjust to change
both the colour scheme and layout. Start with
the Layout tab to set your overall parameters of
size and position.

Powerful tools

Whatever you do, whether you’re in image-editing,
graphic design, web development or motion
graphics, a Creative Cloud membership will
empower you to create stunning work wherever
you are – start on your iOS device and finish in the
studio, or take your work with you wherever you go.
With a Creative Cloud membership you can easily
collaborate and work with creatives across the
globe, sharing files and reviewing documents as if
they were right next to you. And that’s amazing.
For more information on a Creative Cloud
membership, see www.adobe.com/go/creativebloq.

Once you’re satisfied with your first build, you
can publish your ProSite directly from the same
interface. Keep in mind that publishing is only
really the first step: you’ll want to continue to
tweak your design and layout once you can
clearly see your design work in situ.
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Now share some additional work to your
Behance profile from any CC app. In Photoshop,
for example, you’ll find the option under
File>Share on Behance. You can also access the
upload facility from the CC desktop app. Ensure
you upload your work into one of the projects
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photoshop CC 2014

CLICK HERE TO FIND
OUT MORE ABOUT
PHOTOSHOP CC
2014!

THE NEW FEATURES Of

Photoshop CC 2014
Photoshop is the world’s leading image-editing application‚ and for
good reason. The 2014 release brings a plethora of new tools – all
aimed at increasing your creativity and sharpening your workflow.
Here’s what’s new and why you should be joining Creative Cloud and
downloading the new release right now!

Improved Smart Guides

Smart Guides is a handy feature that’s perfect for
designers who are creating mockups inside
Photoshop. They make it easy to position elements
in relation to each other so that spacing is perfectly
balanced, or two objects align along an axis.
Photoshop CC 2014 brings enhancements that
make Smart Guides easier to use, with a new
method of displaying the distance and alignment
of two elements, along with handy snapping options.

now features an all-new selection tool, called Focus
Mask. Focus Mask creates selections by examining
which areas of the image are in focus, and selecting
these parts. It’s a really useful automatic way to get a
selection started, although as with all the selection
tools you’ll need to manually tweak the initial
selection to get best results.

New Blur effects

Photoshop CC 2014 adds two new blur filters to
the Blur Gallery: Path Blur and Spin Blur. Path blur,
as the name suggests, enables you to add blur along
a path that’s either straight or curved. This opens up
a range of creative possibilities for creating a feeling
of movement. Spin Blur enables you to create
elliptical blurs perfect for making objects within the
frame appear to be rotating – think in terms of
wheels, vinyl and so on.

Improved Layer Comps

The idea of Layer Comps has always been a good
one, but they have, in the past, been a little bit
clunky to use. The latest iteration of Photoshop
provides a significant workflow upgrade to Layer
Comps, with a redesigned Layer Comps panel that
shows which attributes each Layer Comp controls
– and you can sync changes to multiple Layer
Comps. Additionally, when a Smart Object contains
Layer Comps, you can choose which Layer Comp is
displayed. A great update.

Typekit integration
Focus Mask
Running with the Fairies

This amazing image by Estonian fine art
photographer Kylli Sparre is on the Photoshop
CC 2014 splash screen. See more of Sparre’s
work at www.behance.net/Sparrek.

Much of the work involved in post-processing an
image inside Photoshop centres around generating,
manipulating and saving selections. This has always
been a strength of the software, but Adobe has
been progressively improving the range of selection
tools with each new version. Photoshop CC 2014

Photoshop CC 2014 has had a variety of
enhancements in the way type and typography is
handled. As well as a new solution for dealing with
missing fonts which automatically fetches fonts from
Typekit where available, there’s also an enhanced
font search feature that makes it much easier to find
the font you’re looking for directly within the Font
Selection menu. Cool, huh!

A d o be c re ativ e c lo ud 2 01 4
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EVANGELIST Q&A: Rufus Deuchler
We caught up with
the Creative Cloud
evangelist earlier this
month to discuss the
changing nature of
Adobe tools and how they can improve
designers’ workflow…
Creative Bloq: What are the standout
elements of Creative Cloud 2014 for you?
Rufus Deuchler: An update that really excites
me in this 2014 release of Creative Cloud is
the workflow that we enable in applications
such as Illustrator, for example, to understand
CSS and SVG. Things that typically were really
hard to produce for designers. Now it’s a
simple copy and paste from Illustrator into the
code or an export from Illustrator to get the
CSS properties that can be used in a web
workflow. In the past designers would use
Photoshop to create their web designs. Now
you can use the precision of pixel-perfect
vector graphics inside of Illustrator.
CB: How do you make sure the changes you
make are the ones the users actually want?
RD: Submissions from the users themselves on
our website – we have a special form for that.
And all of these feature requests make it into a
list for each product. These are then monitored
and they enable us to choose which to
implement. Then there are events like Create
Now where we get to meet the users. And
many of them come to us and talk about their
workflows. We listen to our users a lot. And
then of course there are our engineers, who
may have some ideas that our users are not
even aware of yet. So we combine a focus on
user experience, our experience and futurist
visions of what the applications could do.
CB: What products in the Creative Cloud
family excite you the most and why?
RD: The products that excite me the most as a
designer are Photoshop, Illustrator and
InDesign, as well as the fact that you can now
use mobile apps to start your creative process.
Also with our new hardware, Adobe Ink and
Adobe Slide, I can really start to ideate on the
iPad. And then there’s the ability to use these
ideas directly from my device – just press a
button and that goes into Photoshop and I can
continue to work on it. All of these new
workflows that we’re enabling are exciting
because it makes everything so much smoother
(and less painful) for the user in the end.
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illustrator CC 2014

THE NEW FEATURES OF

Illustrator CC 2014
The de facto standard in illustration and design, Adobe Illustrator
is the tool you need if you’re serious about creating cutting-edge
illustration, logo, UI and other vector-based graphics. The 2014
release brings some great new tools to the app – so check them
out and see your creative workflow skyrocket!

Live Shapes

The headline feature in Illustrator CC 2014 is Live
Shapes. This enables you to create and control the
dimensions and radii of rectangles and rounded
rectangles dynamically, either with on-art controls,
or by entering precise numbers in the Transform
panel. It used to be that once you’d created a shape
inside Illustrator, it was a path and that was that.
Rectangles now have quickly modifiable corners,
including independent radius control for each
corner. As well as this, corner attributes are retained
if you scale and rotate your rectangle – and
Illustrator is clever enough to remember your
settings so that you can quickly return to your
original shape if desired. This is a small tweak but
makes a noticeable difference when drafting
mockups, for example.

Pen tool preview

The Pen tool has been upgraded so that you can
now see a preview of the path you’re drawing
before you click to place the next point. This
preview takes the form of a rubberband-like ghost
line, showing how your point will affect the path if
you click to drop an anchor. This takes a bit of
getting used to, especially if you’re a long-time
Illustrator user, but it makes the Pen tool far easier
to understand for new users, and provides a handy
preview that enables you to achieve more
predictable results first time, every time.

CLICK HERE TO FIND
OUT MORE ABOUT
ILLUSTRATOR CC
2014!

Typekit missing fonts workflow

Illustrator CC 2014 enables you to check for
missing fonts on Typekit with a single click. It’s not
going to solve the issue where a custom font has
been used, but if you’re working on a file with fonts
that came from Typekit it essentially solves the issue
outright. Handy!

Snap to pixel, point, and grid updates

Anchor Point enhancements

The way you work with anchor points in Illustrator
has become much more flexible in Illustrator CC
2014. You can now make anchor point handles
unequal. Previously, when you dragged the handles
of a smooth point using the Pen tool, they remained
equal in length and paired. Now, if you press the Ctrl
or Cmd key as you drag, you can keep them paired
but make them unequal in length.
	In addition, you can repair broken
handles. You break the pairing of anchor point
handles in order to create corners in a path – but
sometimes you need to make a corner point smooth
again. There were ways to do this in the past, but
they affected the original curve. Now you can use
the Anchor Point tool, along with the Alt or Option
key, and click on one of the handles to make the
point smooth. This pairs the anchor point handles,
making the point smooth, but keeps the opposite
curve intact.
	In addition, in Illustrator CC 2014, you
have better control when closing paths. Previously, if
you started drawing a shape with a smooth point,
your initial curve would change when you closed the
path. Now, when you close a path it’s much easier to
keep the initial shape. Finally, the ability to
reposition a closing point is great – as you finish
drawing a shape, you can now reposition the final
closing point as you’re drawing.

Adob e creative cloud 2 014
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When snapping is turned on, your anchor points
align perfectly to your choice of pixel, grid, or point.
But your anchor handles should not. They’re now
disengaged from snapping so you can preserve the
precision of your curves and achieve fine control
while editing – essential for those working on
precise illustrations, UI elements or logo designs.

Illustrator Lion

The artwork on the Illustrator CC
2014 splash screen was created by
Patrick Seymour. Find out more at
www.behance.net/
patrickseymour.
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dreamweaver cc 2014

THE NEW FEATURES OF

CLICK HERE TO FIND
OUT MORE ABOUT
DREAMWEAVER
CC 2014

Dreamweaver CC 2014
Adobe’s popular web tool has a ton of new capabilities in the CC
2014 release. Huge efforts have been made by the company to
address workflow bottlenecks, fix annoyances and speed up the web
development process. There’s a host of improvements in this release
that are guaranteed to speed up your web workflow…

New CSS Designer

The CSS Designer has been significantly enhanced
in Dreamweaver CC 2014 including tabbed controls
that make it easier to set border properties and
reduce the amount of clutter (and make it easier to
spot the individual properties you want to work
with). There’s also a handy new Box Editor that
eases the development of rounded corners, padding
and margin when creating text boxes. The selectors
engine has also been upgraded, making it easier to
control the amount of specificity being applied to a
particular CSS selector.

Copy and paste styles

Dreamweaver now enables you to copy styles
directly from one selector to another. You have the
ability to either copy all styles, or simply choose a
subset from style categories such as Layout, Text or
Border. Copying styles is a simple case of right/Ctrl
and clicking an element selector, and choosing the
styles you’d like to copy from the pop-up menu. This
isn’t a dramatic feature but it has the potential to
save so much time in your web workflow.

interactive HTML tree. This works for both static
and dynamically generated content, and you
can modify the structure directly from the tree –
handy for dragging content around. Element Display
enables you to quickly identify available classes
and IDs, assigning and associating them with specific
HTML elements from within Live View – another
great productivity boost.

Live Insert

Live Insert is new to Dreamweaver CC 2014, and
enables you to insert HTML elements directly into
your document from within Live View. Using the
Insert panel, new elements are rendered into the
document in real time without having to switch to
Design/Code view and back.

Element Quick View and Display

The new Element Quick View features enable you
to view the markup in your document as an

Live View Property Inspector
Rollercoaster

The new splash screen for Adobe
Dreamweaver CC 2014, created by Atelier
Olschinsky. See www.behance.net/olschinsky.

Along the same vein, the Property Inspector is now
also available in Live View – enabling you to quickly
identify the properties affecting a specific element,
and make edits to that element without having to
swap back to Design/Code view.
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EVANGELIST Q&A: Michael Chaize
The senior Adobe
evangelist explains why
web designers should
be excited about
Creative Cloud 2014…
Creative Bloq: As a Senior Creative Cloud
evangelist, what does your role at Adobe
involve, exactly?
Michael Chaize: The mission of an evangelist is
to inspire the community of creatives, and
excite them about all the new features of
Creative Cloud 2014. And also to explain how,
for example, a photographer can become a
video maker or how a traditional designer can
become an object designer thanks to the
technologies that are available in Creative
Cloud 2014.
CB: Edge Code and Dreamweaver take
different approaches to CSS, HTML,
JavaScript and web development, but there
are a lot of similarities. How does a designer or
developer decide which tool to use?
MC: If you want to design and publish a
website you have several options. You have
Adobe Muse if you are a traditional designer
and you don’t want to deal with the code. You
have Dreamweaver, with the powerful new Live
View. If you’re a pure developer and you really
want to quickly code and add CSS properties,
then there’s Edge Code – a very light and
powerful code editor. Edge Code is based on
Brackets, an open source project. Brackets and
Edge Code are not only developed by Adobe
engineers – a lot of people from the community
contribute and add features.
CB: What areas of Creative Cloud 2014
should excite people working in web design?
MC: What excites me for all web designers in
this new release is the fact we used to have
what we called a ‘web segment’ with the web
tools. But now, the web is everywhere and in all
the Creative Cloud 2014 apps, including
Illustrator for instance, where you can directly
design a page and then extract all the CSS
properties and generate the assets. The same
goes for Photoshop. Now you can generate the
assets – just naming a layer for instance ‘icon.
png’ will generate the png file in the
background. We’ve added new features in
Photoshop for layout designers. If you want to
easily place elements on the page you have
Smart Guides. There are a lot of new
technologies enabling you to quickly lay out
your web pages.
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premiere CC 2014

THE NEW FEATURES OF

Premiere Pro CC 2014

The video editing powerhouse that is Premiere Pro CC has
received some fantastic new additions in the 2014 release. Here
we outline the headline updates – after joining Creative Cloud
and downloading the new version, your video-editing workflow
will go through the roof!

any adjustments you make at the master-clip level
ripple down through all clips sections used within
sequences. This means making large-scale changes
to your projects can be done with ease.

A faster editing workflow
Masking and Tracking enhancements

In Premiere Pro CC 2014 you can create feathered
masks that obscure or highlight objects by following
their movement across frames. In addition, you can
send masks to After Effects via Dynamic Link to
access more advanced tracking features. These
features bring full masking and tracking abilities to
all visual effects in Premiere Pro CC. Great, huh?

With Premiere Pro CC 2014, you now have better
handling of large projects plus faster sorting and
searching in the Project panel. There are also
multiple new editing features – Adobe has
responded to key customer requests – and you’ll
find reverse match frame and volume keyframe
nudge. Add to this enhanced graphics performance
in the Mercury Playback Engine and you have a
lightning-fast editing tool.

Live Text Templates

With this ace new feature you can modify the text in
After Effects compositions without leaving Premiere
Pro CC 2014. Bear in mind that this new feature
does require you to be using the 2014 release of
After Effects. A great workflow enhancement for
anyone regularly switching between Adobe’s video
editing and compositing applications.

Master Clip effects

The new Master Clip effect provides a powerful
effects workflow in Premiere Pro CC 2014. It works
like this: after you add any effect to a master clip,

New native format support

With Premiere Pro CC 2014, you get built-in
support for the ARRI AMIRA camera, with
appropriate colour LUTs applied as master clips on
import. You also get native support for Sony STtP,
Canon RAW, and improved support for
CinemaDNG formats. This means you can mix
formats on a single timeline and still get the
best-quality performance on a system with a
multi-core CPU and modern GPU (and high disk
throughput). In short, Premiere Pro CC will deal
with any format you throw at it.

Adob e creative cloud 2 014
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CLICK HERE TO FIND
OUT MORE ABOUT
PREMIERE PRO CC
2014!

EVANGELIST Q&A: Jason Levine
Jason Levine is the
principal worldwide
evangelist for Creative
Cloud, focusing on
video products. Here,
he explains what’s new in Creative
Cloud CC 2014 for video professionals
and what’s exciting him so much about
the release…
Creative Bloq: What are the standout video
features of Creative Cloud 2014?
Jason Levine: With CC 2014, we were trying
remove a lot of the typical frustrations and pain
points for editors. For example, we introduced
a new workflow for colour grading between
Premiere Pro and SpeedGrade, called Direct
Link. This was once a workflow that was very
render intensive – rendering out of your NLE
into your grading app, grading, rendering it
back out – now we can send from the Premiere
timeline to SpeedGrade, so you can perform a
grade and send it back. There’s no rendering –
and you’re working with native footage.
	The other thing that I really consider
to be a standout feature are some of the new
masking capabilities and effects changes that
we’ve made in After Effects. There’s a new
Curves effect for instance; and the ability to
apply masks and have effects stay isolated to a
tracked mask. It all functions beautifully
combined with the Global Performance Cache
in After Effects which was introduced a few
versions back. You’re able to create as fast as
you can think now.
CB: What excites you most about working
with video in Creative Cloud?
JL: It’s this idea of what I like to call crosscontinental client collaboration. It’s the idea
that today you can work and collaborate with
people based on talent and not location. And
some of the new folder sharing and
collaborative abilities that we have in Creative
Cloud enable you to do just that. This is a
service that enables you – as part of your
Creative Cloud membership – to embed video
in any number of sites whether it’s Vimeo, Hulu,
YouTube… essentially anywhere. You can also
upload directly to Behance and get feedback
that’s going to help you make something better.
This has opened up a whole new realm of
possibility for me – I’ve started collaborating
with people around the world who I’ve never
met but whose similar artistic sensibilities have
brought us together. Creative Cloud is the
essential piece of that puzzle for me.

Premiere Pro CC

The Premiere Pro CC splash screen
artwork, designed by Holger Lippmann.
See www.behance.net/lumicon for more.
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NEW MOBILE APPS

five new
mobile apps

2
4

1

5

Adobe has rolled out five brand
new applications for iOS. The great
news is they are all available for free
– although of course you’ll need a
Creative Cloud membership to make
the most of them.
	The thread tying these apps
together is the new ability to use the
cloud for raw processing muscle.
In other words, some functions are
actually uploaded to Adobe servers
and you use their processors to chug
through your photo-manipulations.
That means you can do some pretty
processor-heavy design work on the
iPad! These apps are in addition to
Adobe Ideas, Kuler and Voice for iOS.
So let’s take a look…

1

CLICK HERE TO FIND
OUT MORE ABOUT
ADOBE’S NEW
IOS APPS!
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NEW MOBILE APPS

3

Creative Cloud app

This is a new app that enables Creative Cloud
members to access and manage their files, assets,
and more from their iPhone or iPad.
And what about Android, you might ask?
Adobe says that research shows its membership
base is overwhelmingly using iOS devices, and so it
has are no immediate plans to develop Android
versions of any of the apps featured here.
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Photoshop Mix

Photoshop Mix brings the power of Photoshop to
the iPad, with processing handled by the cloud to
make editing images and layouts on the go a reality.
	Built using the Adobe Creative SDK
– which has been opened up to developers as part
of the Creative Cloud 2014 release – the app is
designed to work seamlessly with your desktop
version of Photoshop while you’re on the move.
	Use your iPad to open Photoshop
documents and individual layers from PSDs; create
selections and masks; access Photoshop features
like Upright, Content-Aware Fill and Camera Shake
Reduction; then export your layered composition to
Photoshop CC for further refinement later. Ace!

3

Lightroom Mobile

Following its April 2014 release on iPad, Lightroom
Mobile is now available for the iPhone. A way to
manage and edit images across desktop, mobile
devices and the web, Lightroom enables you to
automatically import images from your iPhone’s
camera roll and sync them to a Lightroom catalog
on the desktop.
Additionally, the recently announced
Adobe Voice – a free app for iPad enabling you to
create animated stories – has been updated to work
with your Lightroom catalogs.

4

Adobe Sketch

Sketch is an iPad app for freeform drawing on the
move. Providing designers with a connected process
that works with the rest of the company’s Creative
Cloud tools, it provides essential drawing tools in
digital form: a graphite pencil, an ink pen, two
blending markers, brush tip, chisel tip, and an eraser.
It also enables you to get live feedback from the
creative community via Behance as you work.
Sketch has been optimised for use with
Adobe’s new digital pen (Adobe Ink) and ruler
(Adobe Slide). See page 16 for more on those.
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Adobe Line

Adobe Line is an iPad app designed for precision
drawing and drafting. As Adobe puts it: “Line
recreates the art of drafting, combining organic
drawing with beautiful straight lines, French curves
and perfect shapes that can be drawn in plan and
elevation views, or in perspective.”
	Line brings virtual versions of traditional
drawing tools like rulers, T-squares and shape
templates to your tablet, and you can also use the
app to access assets and Kuler colour themes via
Creative Cloud.
Again, it’s optimised for use with Adobe
Ink and Slide, but you don’t need them to use it.
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ADOBE INK AND SLIDE

PERSONALISE IT!
You can choose the colour
of the LED light on Ink.
You’ll always know exactly
which device is yours!
PERFECT SHAPES
Slide lets you draw any
shape on your iPad — including
straight lines, perfect circles,
classic French curves, and more.
All at a touch of a button.

Hydro-formed
Ink has a stunning premium
design and the hydro-formed
aluminium shell feels great in
your hand.

cR E AT I V E C L O U D 20 1 4

ADOBE INK AND SLIDE

Ink and slide
a new way to create
Introducing Adobe Ink and Slide – two essential pieces of hardware
that team up perfectly with Creative Cloud 2014…
Yes, it’s known across the globe for its software, but Adobe has now made its first foray into hardware with
the introduction of two new, and frankly stunning, products.
	The new digital pen and ruler have been christened Adobe Ink and Adobe Slide. They’re
currently only available in the US through Adonit and will be rolled out in other territories later in the year.
They require an iPad (4th generation), iPad Air, iPad Mini or iPad Mini with Retina display. So what are they
and what do they do? Let’s find out…

EASY ACCESS
The single button on Ink gives
you quick access to tools inside
Adobe’s mobile apps, enabling
you to concentrate on sketching
and not finding menu items.

Pixelpoint tip
Built using Adonit Pixelpoint
technology, Ink has a
pressure-sensitive, fine tip.
Perfect for sketching ideas in
Adobe’s range of mobile apps.

SLICK DESIGN
Slide has a stunning contemporary
design crafted out of aluminium – it
perfectly complements the look
and feel of your iPad.

Adobe Ink
This undeniably cool bit of kit is a three-sided
hydro-formed aluminum stylus for iPad. The
fine-tipped, pressure-sensitive pen is lightweight and
balanced for a comfortable grip. The idea is that Ink
mimics a traditional pen more closely – the nib is
smaller and offers much more control than other
devices, and its ergonomic design offers supreme

cONNECTED TO CC
Like Ink, Slide enables you to
store all of your themes, images,
brushes and so on – and then
access them on any iPad!

Adobe Slide
comfort for those sketching a lot on iPad. The unique
selling point of the device is the way it connects to
Creative Cloud, giving designers access to their
creative assets – including drawings, photos and
Adobe Kuler colour themes (you can take all your
assets, Kuler themes and so on wherever you go and
transfer them to any iPad – pretty neat, huh?).
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There’s an LED on the end of the device, making it
easy to spot which device is yours and see whether
it’s connected to an iPad. Ink comes with a charger
that also acts as a case, and the button on the device
enables quick access to tools inside Adobe’s mobile
apps. A precision stylus combined with Creative
Cloud integration makes Ink an invaluable bit of kit.

Adobe Slide is a digital ruler and companion to Ink
for iPad. Taking a modern twist on traditional tools,
Slide is designed for precision sketching and will help
you to draw straight lines, perfect circles, French
curves and balanced shapes on the iPad. And like
Adobe Ink, it stores all of your Creative Cloud assets
for quick access.

Slide certainly looks minimal, but its power will
surprise you. A single button gives you access to
libraries of shapes in Adobe’s mobile apps. It’s easy to
set up: just like Adobe Ink, pair the device with your
iPad (and Adobe’s mobile apps) via Bluetooth and
you’re pretty much away. A fantastic, and precision
tool for any designer working on the move.
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CLICK HERE TO FIND
OUT MORE ABOUT
ADOBE INK
AND SLIDE!

CR E AT I V E C L OUD M Y T HS

CREATIVE CLOUD 2014

CLICK HERE TO FIND
OUT MORE ABOUT
A CREATIVE CLOUD
MEMBERSHIP

the O U T R A G E O U S E I G H T

creative cloud myths

Putting the record straight…
Since Adobe launched Creative Cloud there has been much discussion on how
it works and what it includes. Here are the top eight myths about the service – as
debunked by Adobe evangelist Terry White on his blog at www.terrywhite.com

1 Apps don’t run in the browser

When people hear “cloud” they get visions of
running applications in a web browser. While that
may be the case with other cloud offerings, it’s not
the case with Creative Cloud. Creative Cloud
members download and install their Apps as Adobe
customers always have. The apps like Photoshop,
Illustrator, InDesign and even Muse runs from your
hard drive, not from the cloud.

2 You don’t have to be constantly connected

Once we get past the fact that you download the
apps and install them on your hard drive, people still
sometimes think that they need to be connected to
the internet to actually run the apps. This is not true.
Your apps not only install on your hard drive, they
also can very much run offline.
Your computer does have to connect to
the internet once a month to verify that your
membership is still current, but that’s it. Once that
check has happened you can disconnect. You will
need to be online when you install and license your
software. If you have an annual membership, you’ll
be asked to connect to the web to validate your
software licenses every 30 days. But, you’ll be able
to use products for 99 days even if you’re offline.

3 My clients/colleagues have to be members!

With your Creative Cloud membership you get
20GB of cloud storage. You can use this storage to
sync files between your devices and access them via
the iOS apps like Photoshop Mix and Adobe Sketch.

If you place files in your Creative Cloud folder on
your hard drive those files will not only be
accessible when you’re offline, but you can also log
into creative.adobe.com and share them. Once you
decide to share a file you can email a link to your
colleagues or clients and they will be able to view
your file in their web browser even if they’ve never
heard of Creative Cloud or the Adobe applications
you used to create them. They don’t have to create
an account or register for anything.

for workflows that involve working with clients or
vendors that may not be on the latest versions of
the software. Creative Cloud paid members have
access to a select set of archived versions of the
desktop apps. Starting with CS6, select older
versions of the desktop creative apps will be
archived and available for download, but not
updated for the latest operating systems.

4 I’ll lose all my files if I leave

With Creative Cloud you’re allowed to install
the software on up to two of your computers.
Just like you are able to do with the Creative
Suite applications. However, unlike Creative Suite,
Creative Cloud allows you to download and install
either the Mac or Windows versions for each
computer. This is great for people that have say
a Windows PC at work, but a Mac at home.

When you create files with the various creative
apps from Adobe, the files are yours. Adobe
doesn’t take any ownership or copyright of those
files. If you decide to no longer be a Creative
Cloud member then you won’t have access to your
Creative Cloud applications anymore, but if you’ve
got previous CS app versions, you’ll be able to open
your files provided that you’ve saved them down to
compatible formats with your older applications or
other third-party applications. If you ever decided to
re-join Creative Cloud you’ll have access to the
latest Creative Apps again and you’ll be able to
continue working on your files.

5 I’m forced to use latest versions of apps

With Adobe Creative Cloud you will always have
access to the latest Adobe Creative Applications,
but you aren’t forced to upgrade. You can continue
to run whichever versions of the software that you
want until you are ready to upgrade. This is crucial
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6 I have a Mac and PC – I don’t want to
join Creative Cloud twice

7 I don’t want to pay monthly

You can buy a year of Creative Cloud at once.

8 I only want to use Photoshop CC – the price is
too expensive for just that app
You can get a Single App membership, or even
better, the Photography membership – giving you
Photoshop CC and Lightroom (plus a host of
Creative Cloud services) for just £8.78 per month.
Decide which plan is right for you by going to
www.adobe.com/go/creativebloq.

F ind out mo r e about an A dobe C r eati v e C loud
subsc r iption at www . adobe . com / go / c r eati v ebloq

